
PA 800 Plus EmpowerTM Driver
User Guide

March 2020RUO-IDV-03-9721-A



This document is provided to customers who have purchased SCIEX equipment to use in the operation of
such SCIEX equipment. This document is copyright protected and any reproduction of this document or
any part of this document is strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against the
law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license
agreement. Furthermore, the license agreement may prohibit the software from being disassembled, reverse
engineered, or decompiled for any purpose. Warranties are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which may
contain parts whose names are registered as trademarks and/or function as trademarks of their respective
owners. Any such use is intended only to designate those manufacturers' products as supplied by SCIEX
for incorporation into its equipment and does not imply any right and/or license to use or permit others to
use such manufacturers' and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale or license of its
products and are the sole and exclusive representations, warranties, and obligations of SCIEX. SCIEX
makes no other warranty of any kind whatsoever, expressed or implied, including without limitation, warranties
of merchantability or fitness for a particular purpose, whether arising from a statute or otherwise in law or
from a course of dealing or usage of trade, all of which are expressly disclaimed, and assumes no
responsibility or contingent liability, including indirect or consequential damages, for any use by the purchaser
or for any adverse circumstances arising therefrom.
(GEN-IDV-09-10816-B)

For Research Use Only. Not for use in Diagnostic Procedures.
Trademarks and/or registered trademarks mentioned herein are the property of AB Sciex Pte. Ltd., or their
respective owners, in the United States and/or certain other countries.

AB SCIEX™ is being used under license.
© 2020 DH Tech. Dev. Pte. Ltd.

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

User GuidePA 800 Plus EmpowerTM Driver
RUO-IDV-03-9721-A2 / 62



1 Introduction..............................................................................................................................................5
Related Documentation............................................................................................................................5
EmpowerTM Software Terminology for 32 KaratTM Software Users........................................................6
PA 800 Plus EmpowerTM Driver License.................................................................................................7

2 Direct Control...........................................................................................................................................8
Instrument Status in the Direct Control Pane...........................................................................................9
Parameters and Buttons in the Direct Control Pane..............................................................................12

3 Create an Instrument Method................................................................................................................14
General Parameters for an Instrument Method.....................................................................................17
Detector Parameters for an Instrument Method.....................................................................................19

About the Filter Parameter................................................................................................................23
Add Events to the Time Program for an Instrument Method..................................................................24

4 Define the Buffer and Sample Trays.....................................................................................................26

5 System Maintenance..............................................................................................................................29
Change the Detector..............................................................................................................................29
View the Deuterium Lamp Spectrum and Intensity................................................................................30
Change the Deuterium Lamp.................................................................................................................32
Calibrate the PDA Detector....................................................................................................................35
Calibrate the LIF Detector......................................................................................................................37

6 Troubleshooting.....................................................................................................................................42

A Time Program Events............................................................................................................................44
Parameters for Time Program Events....................................................................................................51

About the Duration for Pressure and Vacuum Events......................................................................53
About Tray Positions.........................................................................................................................54
About Vial Incrementing....................................................................................................................55

B Plate Definition Files.............................................................................................................................56
PA800Plus Sample Tray Plate Definition File........................................................................................57
PA800Plus 96 Well Sample Tray Plate Definition File...........................................................................58
PA800Plus Buffer Tray Plate Definition File...........................................................................................59

C Topics for Familiarization.....................................................................................................................60

Contact Us.................................................................................................................................................61
Customer Training..................................................................................................................................61
Online Learning Center..........................................................................................................................61
Purchase Consumables.........................................................................................................................61

PA 800 Plus EmpowerTM DriverUser Guide
3 / 62RUO-IDV-03-9721-A

Contents



SCIEX Support.......................................................................................................................................61
CyberSecurity.........................................................................................................................................61
Documentation.......................................................................................................................................62

User GuidePA 800 Plus EmpowerTM Driver
RUO-IDV-03-9721-A4 / 62

Contents



This document provides instructions for using Waters EmpowerTM Software with a PA 800 Plus
System. The PA 800 Plus EmpowerTM Driver must be installed on the computer with the EmpowerTM

Software. Refer to the PA 800 Plus EmpowerTM Driver Release Notes for installation instructions.

This document includes instructions for calibrating the detectors in the PA 800 Plus System.
Instructions for direct control of the PA 800 Plus System using the EmpowerTM Software are also
provided.

Note: Refer to the System Overview Guide for instructions for safe use of the system.

The EmpowerTM Software can also be used with the CESI 8000 Plus High Performance
Separation-ESI Module if an LIF, PDA, or UV detector is installed.

Related Documentation
This document assumes some knowledge of the EmpowerTM Software. For instructions on general
features of the EmpowerTM 3 (FR4) Software:

• Refer to the documentation supplied with the software.

• Click on the Empower Start dialog

• Click Help in any of the EmpowerTM Software programs.

For detailed instructions on using the EmpowerTM Software for a specific capillary electrophoresis
application, refer to the following application guides.

• Fast Glycan Labeling and Analysis Kit Application Guide

• Capillary Isoelectric Focusing (cIEF) Analysis Application Guide

• IgG Purity and Heterogeneity Assay Kit Analysis Application Guide

For information about the PA 800 Plus System:

• For a general introduction to the system, refer to Chapter 1 in the PA 800 Plus Pharmaceutical
Analysis System Overview Guide.

• For instructions on maintaining the system, refer to the PA 800 Plus Pharmaceutical Analysis
System Maintenance Guide.
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EmpowerTM Software Terminology for 32 KaratTM

Software Users
Users who have used the PA 800 Plus System with the 32 KaratTM Software will need to become
familiar with the EmpowerTM Software terms.

Table 1-1 EmpowerTM Software Terminology for 32 KaratTM Software Users

DescriptionEmpowerTM Software
Equivalent

32 KaratTM Software Term

A method containing system parameters
required for data acquisition. Parameters

Instrument MethodNo equivalents in 32
KaratTM Software

are grouped as general parameters,
detector parameters, and a time program.

A method containing data processing
parameters.

Processing Method

A method to create a report showing the
results of the processing method.

Reporting Method

A combination of an instrument method,
a processing method, and a report
method. Processing and report methods
are optional.

Method SetMethod

A list of samples and associated method
sets that is sent to the PA 800 Plus
System for data acquisition. Optionally,
the EmpowerTM Software can perform
post-acquisition data processing and
generate reports.

Sample Set MethodSequence

A file containing information about the
results of the data acquisition. Reports
can also include information about the
organization generating the data. The
layout and appearance of a report can
be customized and saved as part of a
report template.

ReportReport

The tray or 96-well plate that holds the
samples to be analyzed.

PlateSample Tray
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Table 1-1 EmpowerTM Software Terminology for 32 KaratTM Software Users (continued)

DescriptionEmpowerTM Software
Equivalent

32 KaratTM Software Term

The tray that holds the vials that contain
the buffer and rinse solutions.

PlateBuffer Tray

The computer that controls the PA 800
Plus System.

LAC/E moduleController

PA 800 Plus EmpowerTM Driver License
To collect and analyze data with the PA 800 Plus EmpowerTM Driver a USB license key is required.
The license key should be inserted in a USB port on the EmpowerTM Software LAC/E acquisition
server.

If the license key is not present, then all controls in the Direct Control pane are disabled. In
addition, data acquisition will not begin. If the license key is removed during data acquisition, then
acquisition for the current method set finishes but no additional data acquisition will start.

The license key can be removed from one LAC/E acquisition server and inserted in a USB port
on another computer if required.
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This section describes how to control the PA 800 Plus System using the Direct Control pane in
the EmpowerTM Software.

There are three sections in the Direct Control pane. From top to bottom:

• Instrument status pane: Shows the status of the system. Refer to Instrument Status in the Direct
Control Pane.

• Status field: Shows the status of the system or any process taking place on the system. Errors
are also shown in red text in this field

• Parameter tabs and buttons: Set the parameters for the system. Depending on the type of
detector, different tabs are shown. Refer to Parameters and Buttons in the Direct Control Pane.

Figure 2-1 Direct Control Pane (PDA Detector)
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Instrument Status in the Direct Control Pane
Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi), depending
on a registry setting for the EmpowerTM Software. The default unit is millibar. To change the units,
refer to the PA 800 Plus EmpowerTM Driver Release Notes.

Figure 2-2 Instrument Status in the Direct Control Pane (LIF Detector)

DescriptionLabel

Shows the voltage, current, and power.Control

Shows the temperature of the cartridge and sample cooling
system.

Temperature

Shows the location of the capillary inlet and outlet.Tray

Shows information about the LIF detector.

• Channels: The channel for the data, Ch1 and Ch2.

• RFU: The relative fluorescence units of the data in this
channel.

LIF Detector

Shows the direction and the magnitude of the pressure or
vacuum.

• : forward direction

• : reverse direction

• +: pressure

• –: vacuum

Pressure

Shows the status of the coolant, OK or Low.Coolant

PA 800 Plus EmpowerTM DriverUser Guide
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DescriptionLabel

(LIF detector) Shows the status of the laser, On or Off.Lasers

(LIF detector) Shows the number of hours that the laser has
been on.

• 1 Hours for the integrated 488 nm laser.

• 2 Hours for an external laser, if installed.

Laser Hrs

Figure 2-3 Instrument Status in the Direct Control Pane (PDA Detector)

Note: For items common to all detector types, refer to Figure 2-2.

DescriptionLabel

Shows the status of the lamp, On or Off.Lamp

Shows the number of hours that the lamps have been on.

• D2: The number of hours the deuterium lamp has been on.

• Hg: The number of hours the mercury lamp has been on.

Lamp Hrs

Shows information about the PDA detector.

• Chan: The channel for the data.

• Wv: The wavelength for the channel, in nm.

• Bw: The bandwidth for the channel, in nm.

• Absorb: The absorbance for the channel.

PDA Detector
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Figure 2-4 Instrument Status in the Direct Control Pane (UV Detector)

Note: For items common to all detector types, refer to Figure 2-2.

DescriptionLabel

Shows the status of the lamp, On or Off.Lamp

Shows the number of hours that the lamps have been on.

• D2: The number of hours the deuterium lamp has been on.

• Hg: For display only. Not used for the UV detector.

Lamp Hrs

Shows information about the UV detector.

• Chan: The channel for the data.

• Wv: The wavelength for the channel, in nm.

• Absorb: The absorbance for the channel.

UV Detector

Click to view filter information.

Figure 2-5 Instrument Status in the Direct Control Pane (UV Filters)

Note: For items common to all detector types, refer to Figure 2-2.
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DescriptionLabel

Refer to Figure 2-4.Lamp

Refer to Figure 2-4.Lamp Hrs

F<x>: Shows the wavelength of the filter in position <x>, in
nm.

UV Filters

Click to view detector information.

Parameters and Buttons in the Direct Control Pane
Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi), depending
on a registry setting for the EmpowerTM Software. The default unit is millibar. To change the units,
refer to the PA 800 Plus EmpowerTM Driver Release Notes.

Figure 2-6 Parameters and Buttons in the Direct Control Pane

DescriptionLabel

Parameter Tabs

Set the pressure for the system.Pressure Settings

Set the voltage for the system.Voltage Settings

Set the temperature for the capillary and sample cooler.Temperature

(UV or PDA detector) Turn the lamp on or off.Lamp On/Off
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DescriptionLabel

(LIF detector) Turn the laser on or off.Laser On/Off

(LIF detector) View the calibration correction factors and set
the parameters for detector calibration. Refer to Calibrate the
LIF Detector.

Calibration Factors

(UV detector) Set the position and wavelength of filters
installed in the system.

UV Filters

(UV or PDA detector) After replacing the lamp, set the lamp
hours to 0.

Lamp Hours

(UV detector) Select filter in the Filter list and then click Set
to view the current between the diodes in the deuterium lamp,
in nA. This value decreases over time due to the lamp aging.

Lamp Energy

View the type of sample and buffer trays in use.Trays

(PDA detector) View the spectrum of the deuterium lamp.
Refer to View the Deuterium Lamp Spectrum and Intensity.

Spectrum

Buttons

Click to view the next or previous tab.

Click to view the help pane.

Click to close the help pane.

Click to move the trays to the home position.Home

Click to move the trays to the load position.Load

Click to send the parameters to the PA 800 Plus System.

• (LIF detector) When the Calibration Factors tab is shown,
this button changes to Start.

• (UV detector) When the Lamp Hours tab is shown, this
button changes to Reset.

• (PDA detector) When the Spectrum tab is shown, this
button changes to Monitor.

Set

Click to turn off the voltage, current, power, pressure, and
cooling.

Stop

(PDA detector) Click to calibrate the PDA detector. Refer to
Calibrate the PDA Detector.

Advanced

PA 800 Plus EmpowerTM DriverUser Guide
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1. In the EmpowerTM Software Project window, click File > New Method > Instrument Method.

The Select Desired Chromatography System dialog opens.

Figure 3-1 Select Desired Chromatography System Dialog

2. Click the system to be used and then click OK.

Make sure that the instrument is configured with the required detector for the application.
The Instrument Method Editor opens.

3. Click the Detector tab, select the detector from the Detector Type list, and then set the
parameters. Refer to Detector Parameters for an Instrument Method.

Note: If it is necessary to change Detector Type, change it first before making any other
changes to the instrument method. When the Detector Type changes, all parameters are
set to their default values.
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Figure 3-2 Detector Parameters

4. Click the General tab and then set the parameters. Refer to General Parameters for an
Instrument Method.
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Figure 3-3 General Parameters

5. Click the Time Program tab and then add events to the time program. Refer to Add Events
to the Time Program for an Instrument Method.

The EmpowerTM Software requires that the last event in the time program is an End event.

Figure 3-4 Time Program

6. Save the instrument method.

a. Click File > Save to open the Save current Instrument Method dialog.

b. Type a name in the Name field.

c. (Optional) Type information in the Method Comments field.
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d. If prompted, type the EmpowerTM Software login password for current user in the Password
field and then click Save.

The instrument method is saved to the current project.

General Parameters for an Instrument Method

Figure 3-5 General Parameters for an Instrument Method
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DescriptionLabel

Select additional types of data to be collected: Voltage, Current,
Pressure, and Cartridge Temperature.

For Voltage, Current, and Power, specify the maximum value to
be applied during data collection.

Auxilliary Data Channels

Select Wait For External Trigger if the method is to be triggered
by an outside source or device.

Select an option to start the run based on temperature. Options
are Do not wait, Wait for Cartridge Temperature, Wait for
Storage Temperature, or Wait for Cartridge and Storage
Temperature.

Trigger Settings

Select the type of sample and buffer tray installed in the inlet
positions.

Inlet Trays

Do not change the parameters in this area. They have no effect
on data acquisition.

Peak Detect Parameters

Type the dimensions of the capillary.Capillary Settings

Type the temperature for the cartridge and the sample cooler.Temperature (ºC)

Select the type of sample and buffer trays installed in the outlet
positions.

Outlet Trays
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Detector Parameters for an Instrument Method

Figure 3-6 Detector Parameters for a PDA Detector

DescriptionLabel

Select the type of detector.Detector Type

Set the sampling rate of the data to be collected, in Hz, and the
wavelength range, in nm, to be scanned.

A higher rate means more data points per peak, but might lead
to more noise. The optimal rate differs by analyte and should be
determined during method development.

Note: The value for Data Rate must be between 25% to 100%
of the Data Rate for the Electropherogram Channel Data.

Electropherogram Scan
Data

PA 800 Plus EmpowerTM DriverUser Guide
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DescriptionLabel

Set the parameters for data collection for up to three channels.
Click Data Rate to select the sampling rate of the data to be
collected.

A higher rate means more data points per peak, but might lead
to more noise. The optimal rate differs by analyte and should be
determined during method development.

For each channel:

• Select Acquire to acquire data from this channel.

• Select Ref to subtract the reference trace data from the data
collected in this channel. The reference is a wavelength that
is recorded and subtracted from the data in the wavelength
channel.

• Type the Wavelength of the data to be collected, in nm.

• Type the Bandwidth of the data to be collected, in nm.

Electropherogram Channel
Data

Click to select the filter to be used when filtering noise in the data.
Refer to About the Filter Parameter.

Filter

For Relay 1 and Relay 2, set the state to Open or Closed.Relays

Type the wavelength and bandwidth for the reference channel, in
nm.

Reference Channel

Select Direct to show the data as received from the detector.

Select Indirect to invert the signal before showing the data.

Absorbance Signal
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Figure 3-7 Detector Parameters for an LIF Detector

DescriptionLabel

Select the type of detector.Detector Type

Select to enable data acquisition for the channel. Data can be
acquired from one or both channels.

Acquisition enabled

Select the upper limit of the data to be collected, in RFU. If the
fluorescence signal is above this limit, then peaks might be
truncated.

Acquisition

Select the filter to be used when filtering noise in the data. Refer
to About the Filter Parameter.

Filter

Select Direct to display the data as received from the detector.

Select Indirect to invert the signal before displaying the data.

Fluorescence Signal

PA 800 Plus EmpowerTM DriverUser Guide
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DescriptionLabel

Type the values for the excitation and emission wavelengths, in
nm. These values are stored with the method but are not used for
acquisition.

The excitation and emission wavelengths used for data acquisition
are determined by the laser wavelength and the emission filter
installed in the LIF detector.

Laser/filter description -
information only

For both channels, set the sampling rate for the LIF data to be
collected, in Hz.

A higher rate means more data points per peak, but might lead
to more noise. The optimal rate differs by analyte and should be
determined during method development.

Data rate

For Relay 1 and Relay 2, set the state to Open or Closed.Relays

Figure 3-8 Detector Parameters for a UV Detector
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DescriptionLabel

Select the type of detector.Detector Type

Type the Data Rate, in Hz, and the Wavelength, in nm, for data
collection.

A higher rate means more data points per peak, but might lead
to more noise. The optimal rate differs by analyte and should be
determined during method development.

Electropherogram Channel
Data

Select the filter to be used when filtering noise in the data. Refer
to About the Filter Parameter.

Filter

For Relay 1 and Relay 2, set the state to Open or Closed.Relays

Select Direct to display the data as received from the detector.

Select Indirect to invert the signal before displaying the data.

Absorbance Signal

About the Filter Parameter
The following types of noise filters are available. For each type of filter, a peak width can be
specified. The types of filter are:

• General Purpose: This is the normal noise filter. It provides a high degree of smoothing with
limited or minimal peak distortion and loss of resolution.

• Max Sensitivity: This filter reduces baseline noise. It maximizes the signal-to-noise ratio, but
might cause broadening or flattening of peaks. Use this for experiments where peaks are
resolved and detection limits or quantitative accuracy is most important.

• Max Resolution: This filter preserves peak shape, but reduces baseline noise less than the
other filter options.

The peak width is the expected peak width at the base of a peak. The ranges are:

• None: No filtering is performed.

• <16 points: The noise filter uses the smallest number of points, which means less smoothing
and more noise.

• 16 - 25 points: The noise filter uses an intermediate number of points.

• >25 points: The noise filter uses the largest number of points, which means more smoothing
and less noise.
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Add Events to the Time Program for an Instrument
Method
The time program is a table of events in an instrument method. The events are executed in order,
top to bottom.

1. Open an instrument method and then click the Time Program tab.

2. Click the Event cell and then select an event. Refer to Table A-1.

Figure 3-9 Event List in the Time Program Tab

Fields for the event parameters appear in the pane below the table.

3. As required, type values for the parameters in the fields to the right. Refer to Table A-2.

Figure 3-10 Edit Event Parameters in the Time Program Tab
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4. (Optional) To show the valid ranges for the parameters, click .

Click to hide the help.

5. As required, right-click a row header and select Insert Row to insert a row in the time program.

The new row appears below the selected row.

6. As required, right-click a row header and select Remove Row to delete the selected row.

7. If this time program includes any of the Separate events such as Separate Pressure, Separate
Current and so on, then add the End event as the last event in the time program.

8. Save the instrument method.

a. Click File > Save to open the Save current Instrument Method dialog.

b. Type a name in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the EmpowerTM Software login password for current user in the Password
field and then click Save.

The instrument method is saved to the current project.
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In the EmpowerTM Software, the sample and buffer trays in the PA 800 Plus System are referred
to as "plates". Plates must be defined in the EmpowerTM Software. To simplify this process, SCIEX
provides text files with the required information that can be imported.

Note: The plates should have been defined when the EmpowerTM Software was installed. If the
list of plates in the Plate Types Name table includes PA 800 Plus Sample Tray, PA 800 Plus
Buffer Tray, and PA 800 Plus 96 Well Sample Tray then the plates have already been defined.
The procedure is included here for reference.

1. Insert the PA 800 Plus EmpowerTM Driver DVD in the DVD drive.

2. In the EmpowerTM Software Start dialog, click Configure the System.

The Configuration Manager window opens.

3. Click Plate Types to show the plates that are already defined.

Figure 4-1 Plate Types in the Configuration Manager Window
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4. Create the plate for the buffer tray.

a. Right-click in the table and then select Import from Text.
b. Click Browse and then navigate to the PA800Plus Buffer Tray.txt file on the PA 800 Plus

EmpowerTM Driver DVD.

Note: If the DVD is not available, then a copy of the file is included in this document.
Copy the contents and then paste it in a text file. Refer to Plate Definition Files.

c. Type PA 800 Plus Buffer Tray in the New Plate Type Name field and then click OK.

Figure 4-2 Import Plate Type From Text File Dialog

The buffer tray is added to the list in the Configuration Manager window.

5. Repeat step 4 to create the sample trays.

• For the 48-vial sample tray, select the PA800Plus Sample Tray.txt file and then name the
plate PA 800 Plus Sample Tray.

• For the 96-well sample tray, select the PA800Plus 96 Well Sample Tray.txt file and then
name the plate PA 800 Plus 96 Well Sample Tray.

As for the buffer tray, if the plate definition file is not available, a copy is available in this
document. Refer to Plate Definition Files.

Note: The plate definition file for the 96-well sample plate is for a standard SCIEX 96-well
plate (PN 609844). To use a 96-well plate from another manufacturer, click File > New >
Plate Type in the Configuration Manager window and then define the plate manually.
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6. If the Beckman Coulter PACE MDQ Control for Waters EmpowerTM Software Driver was
previously installed, then delete any plates that were created for use with the driver. Right-click
the row number for the plate and then select Delete.

7. (Optional) To view detailed information about a plate, right-click the row number for the plate
and then select Properties.

8. (Optional) To delete a plate, right-click the row number for the plate and then select Delete.

Only plates added by a user can be deleted. Pre-defined plates cannot be deleted.

9. Click File > Exit close the Configuration Manager window.
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This section provides instructions for changing the UV lamp and calibrating the PDA and LIF
detectors using the EmpowerTM Software.

Listed below are additional maintenance procedures for the PA 800 Plus System. For instructions,
refer to the PA 800 Plus Pharmaceutical Analysis System Maintenance Guide.

• Installing a UV or PDA Detector

• Installing the UV Detector Wavelength Filters

• Installing a LIF Detector

• Rebuild a Capillary Cartridge

• Filling Vials and Installing Vial Caps

• Cleaning the Interface Block and Ejectors

• Replace the Electrodes

• Refilling the Coolant

• Cleaning the Fiber Optics

• Cleaning the LIF Detector

• Replacing the Quad Rings

• Replace the Fuses

Change the Detector
1. In the EmpowerTM Software, close the Run Samples window.

2. In the EmpowerTM Software Start dialog, click Configure the System to open the Configuration
Manager window.

3. Click Node in the Empower Configuration tree control to show the available nodes.

4. Click the row number corresponding to the appropriate node, and then right-click Bring Offline.

If the system is not in use, that is if no users are connected to it or no samples are being
acquired, then the software takes the system offline. If the system is in use, a message indicates
that the system is in use.

5. Close any open programs and then restart the LAC/E module.
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6. Change the detector. Refer to the PA 800 Plus Pharmaceutical Analysis System Maintenance
Guide.

For a UV detector, make note of the positions any filters installed in the UV source optics
assembly.

7. In the Configuration Manager window, click the row number corresponding to the appropriate
node, and then right-click Bring Online.

8. Click OK to dismiss the message.

9. Do one of the following:

• For a PDA or LIF detector, calibrate the detector. Refer to Calibrate the PDA Detector and
Calibrate the LIF Detector.

• For a UV detector, set the filter information. Refer to step 10.

10. (UV detectors only) Set the filter information.

a. In the Direct Control pane, click and then click the UV Filters tab.

b. For each position in the detector where there is a filter, type the wavelength of the filter.

The default values are shown in the following table.

Table 5-1 Default Filter Wavelengths for the UV Detector

WavelengthPosition

200Filter Position 2

214Filter Position 3

254Filter Position 4

280Filter Position 5

c. Click Set.

View the Deuterium Lamp Spectrum and Intensity
Use this procedure to view the raw counts from the deuterium lamp as seen by the detector. If the
signal is low, this procedure can determine if the UV light intensity is low due to a problem with
the lamp.

The spectrum is a better indicator of lamp life than the Lamp Hours value.
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Required Materials

• PDA detector

• OPCAL cartridge (PN 144660)

1. Install the PDA detector. Refer to Change the Detector and the PA 800 Plus Pharmaceutical
Analysis System Maintenance Guide.

2. In the Direct Control pane, click the Lamp On/Off tab.

3. Click On and then Set to turn the lamp on.

4. Click the Spectrum tab, select 32 in the Scan Rate list, and then click Monitor.

Figure 5-1 Spectrum Tab

When the data is collected, the spectrum is shown.

Figure 5-2 Spectrum Tab with Acceptable Spectrum

5. Inspect the spectrum and the value in the Counts field.

• If the value is above 5000 and the plot is not flat on top, then the lamp is working correctly.
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• If the value is less than 5000, then go to step 6.

• If the plot is flat on top, then the signal is saturated. Select 64 in the Scan Rate list, and
then click Monitor.
If the plot is still flat, select 128 in the Scan Rate list, and then click Monitor.

Figure 5-3 Spectrum Tab with Saturated Spectrum

6. Inspect the cartridge for the following, select 32 in the Scan Rate list, and then click Monitor.
• Make sure that the aperture is clean.

• Make sure that the capillary is clean and not broken.

• Make sure that the aperture is centered on the capillary window.

• Make sure that the fiber optic cable is clean and not broken. Clean or replace as needed.

If the value in the Counts field is still below 5000 at 32 Hz, then go to step 7.

7. Install the OPCAL cartridge, select 32 in the Scan Rate list, and then click Monitor.
If the value in the Counts field is below 10 000, then the lamp might have reached the end of
its useful life or it is defective and should be replaced. Refer to Change the Deuterium Lamp.

Change the Deuterium Lamp
The deuterium lamp is used by the UV detector and the PDA detector. If the baseline is excessively
noisy or the lamp will not illuminate, the lamp may need replacement.
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Required Materials

• Deuterium lamp

• 7/64 in. hex key

• Powder-free gloves

WARNING! Hot Surface Hazard. Before replacing a lamp, turn off the power and
allow sufficient time for the lamp to cool thoroughly. A hot lamp will cause burns.

1. In the Direct Control pane, click Load.

The trays move to the load position.

2. Lift the cartridge cover door.

3. Turn the system power off and allow enough time for the lamp to cool.

4. Loosen the two thumb-screws on the clamp bar and then lift the bar.

5. Remove the capillary cartridge from the interface block.

6. To remove the UV optics source assembly, loosen the two thumb screws, pull the assembly
forward, and then put it on a clean work surface. Refer to Figure 5-4.

Figure 5-4 UV Optics Source Assembly
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DescriptionItem

Access door latch1

Access door2

Thumbscrews (one on each side)3

7. Open the UV lamp access cover on the back of the UV optics source assembly and then
disconnect the lamp power plug. Refer to Figure 5-5.

Figure 5-5 Deuterium Lamp Assembly

DescriptionItem

Power plug1

8. Remove the two 7/64 in. hex screws that secure the UV lamp and then remove the lamp from
the lamp housing.

9. Install the new UV lamp by aligning the flange guide notch in the lamp with the housing guide
pin.

CAUTION: Potential Wrong Result. Make sure that an orange O-ring is installed on the
lamp flange before installing the lamp. A missing O-ring decreases lamp performance.
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CAUTION: Potential System Damage. Use powder-free gloves to handle the UV lamp.
Fingerprints, under the high temperatures and strong UV intensity that come from
operating the UV lamp, form corrosive compounds that etch the surface of the UV lamp
and can cause it to break when it is turned on. When handling the UV lamp, keep the
UV optical window dry and protect it from abrasion.

10. Install the two hex screws and then tighten them until they are snug.

11. Connect the lamp power plug and then close the UV lamp access cover.

12. Put the UV optics source assembly in the mounting location, align the two upper guide pins,
and then tighten the two thumb screws.

13. Install the capillary cartridge in the interface block.

14. Lower the clamp bar and then tighten the two thumb screws.

15. Close the cartridge cover door.

16. Turn on the power.

17. Reset the lamp hours in the EmpowerTM Software.

a. Start the EmpowerTM Software.

b. In the Direct Control pane, click Lamp Hours and then click Reset.

Calibrate the PDA Detector
Note: To make sure that analysis results are consistent over time, we strongly recommend
calibrating the detector each time it is installed in the PA 800 Plus System. Also calibrate the
detector after replacing the capillary in the cartridge or installing a different cartridge.

1. Turn off the PA 800 Plus System and then install the PDA detector.

Refer to the PA 800 Plus Pharmaceutical Analysis System Maintenance Guide.

2. Turn on the PA 800 Plus System and then allow the lamp to warm up for at least 30 minutes.

3. Open the EmpowerTM Software, and then click Run Samples.

The Direct Control pane is visible in the Run Samples window.

Note: If the Direct Control pane is not visible, click View > Control Panels > SCIEX CE.
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Figure 5-6 Direct Control Pane for PDA Detector

4. In the Direct Control pane, click Advanced.

The window updates to show additional parameters.

Figure 5-7 PDA Detector Calibration Parameters

5. Click Calibrate. Do not make any changes to the parameters.

User GuidePA 800 Plus EmpowerTM Driver
RUO-IDV-03-9721-A36 / 62

System Maintenance



The calibration begins. When the calibration is finished, the status field shows "87: PDA
Wavelength calibration successful!", where 87 is the message code.

6. If the calibration is not successful, remove the cartridge and detector, install them again, and
then calibrate.

If the calibration fails a second time, then repeat this step.

7. If the calibration fails a third time, then contact SCIEX Technical Support.

Calibrate the LIF Detector
Note: To make sure that analysis results are consistent over time, we strongly recommend
calibrating the detector each time it is installed in the PA 800 Plus System. Also calibrate the
detector after replacing the capillary in the cartridge or installing a different cartridge.

Calibrate the LIF detector to normalize the reported values for fluorescence relative to a standard.

Required Materials

• LIF Performance Test Mix (PN 726022)

• Depending on the capillary, one of the following:

• For bare a fused-silica capillary: Capillary Performance Run Buffer A (PN 338426)

• For an N-CHO coated capillary: Double-deionized (DDI) water (MS-grade water filtered
through a 0.2 µm filter and with resistance above 18 M )

1. After installing the LIF detector, turn on the PA 800 Plus System and then turn on the solid
state laser.

2. Prepare the vials for the calibration.

a. For a bare fused-silica capillary, dilute 100 µL of LIF Performance Test Mix with an equal
volume of Run Buffer A and then put the micro vial in a universal vial.

b. For an N-CHO coated capillary, add 100 µL of LIF Performance Test Mix to a micro vial
and then put it in a universal vial.

3. Open the EmpowerTM Software, click Run Samples, and if required, log in.

PA 800 Plus EmpowerTM DriverUser Guide
37 / 62RUO-IDV-03-9721-A

System Maintenance



Figure 5-8 EmpowerTM Software Pro Interface Window

4. In the Run Samples dialog, click the folder for the project of interest on the left, click the system
that has the LIF detector installed in the list on the right, and then click OK.
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Figure 5-9 Run Samples Dialog

5. In the Direct Control pane, click Load and then put the vials in the following positions in the
buffer tray.

• Inlet buffer tray position A1: 1.5 mL Run Buffer A (for a bare fused-silica capillary) or DDI
water (for an N-CHO coated capillary)

• Inlet buffer tray position B1: 200 µL diluted LIF Performance Test Mix

• Outlet buffer tray position A1: 1.5 mL DDI water

6. Set the parameters and then start the calibration.

a. In the Direct Control pane, click the Calibration Factors tab and then click Auto.

Figure 5-10 Calibration Factors Tab in Direct Control Pane

b. Click the Detector channel to be calibrated.
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c. Type the Target RFU value. Refer to Table 5-2.

Table 5-2 Calibration Parameters by Capillary

Target RFU
(RFU)

Total length
(cm)

Internal
diameter

(µm)

Type of Capillary

15User-specified50Bare fused-silica

35User-specified75Bare fused-silica

7User-specified50N-CHO coated

d. Type the values for the Internal diameter and Total length of the capillary.

e. Click Start and then click Yes in the dialog that appears.

Figure 5-11 Vial positions Dialog

The calibration begins and takes about 9 minutes to complete. The "Calibration Complete!"
message appears.
If a message stating "No step change detected" appears, then either the capillary is plugged
and the calibration solution is not flowing though it past the detector or the detector cannot
detect the solution. Refer to the "No Step Change Detected" section in the System Maintenance
Guide for troubleshooting procedures.

7. Inspect the CCF value.
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Figure 5-12 Calibration Factors Tab After Calibration

• If the CCF is between 0.1 and 10, it is acceptable. Click Accept.

Note: If the samples will be labeled with a dye other than fluorescein, then we recommend
running a standard to make sure that the system performance is acceptable.

• If the CCF value is less than 0.1 or greater than 10, then it is outside the acceptable range.
Click Cancel and then go to step 8.

8. Check the following and then repeat the calibration.

• Make sure that the capillary dimensions in the Calibration Factors tab are correct.

• Make sure that the correct bandpass filter is installed in the detector.

• Fill clean vials with freshly prepared reagents, cover with clean caps, and then replace the
vials in the tray.

If the CCF value is still less than 0.1 or greater than 10, then there might be a problem with
the laser or the light path. Contact SCIEX Technical Support at sciex.com/request-support.
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Corrective ActionPossible CauseSymptom

1. If the National Instruments
GPIB driver Version 19.0 is
not installed, then install it.

2. If I-488.2 .NET Language
Runtime 17.0.1 for .NET
Framework 4.5 is not
installed, then install it.

1. The wrong version of the
GPIB driver is installed.

2. The wrong version of the
.NET Language Runtime is
installed.

"Instrument Failure" or "System
Error" messages in the
EmpowerTM Software Message
Center window.

Restart the PA 800 Plus
System and then restart the
LAC/E module or the computer
that is physically connected to
the instrument.

After installing the new detector,
the firmware settings were not
downloaded from the PA 800
Plus System to the LAC/E
module or the Instrument
Server does not have the new
settings.

After changing the detector,
"Instrument Failure" or "System
Error" messages in the
EmpowerTM Software Message
Center window.

Inspect the instrument method
and make sure that:
• The pressure is applied to

the correct side of the
capillary or both. Refer to the
appropriate Application
Guide.

• The pressure values are
correct for the units used by
the software, either millibar
or psi. Refer to the PA 800
Plus EmpowerTM Driver
Release Notes for
instructions on changing the
pressure units used in the
software.

The parameters in the
instrument method are not
correct.

The results for the assay are
very different than in shown in
the Application Guide.
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Corrective ActionPossible CauseSymptom

Create a custom calculation for
CE-specific attributes such as
velocity corrected area (VCA).

Some of the capillary
electrophoresis-related
calculations in the EmpowerTM

Software are not optimized for
SCIEX systems.

Results of some data
processing calculations are
very different than similar
calculations in the 32 KaratTM

Software.

Make sure that the vial
increment number agrees with
the number of lines in the
sample set method and
matches the number of runs in
the sample set method.

The Sample Set method is not
correct.

There are pressure or
movement errors when the vials
should be incremented during
a run.

Do not perform data acquisition
on both systems at the same
time or connect each system to
a separate LAC/E module.

Too much data is being
collected due to more than one
PA 800 Plus System connected
to the LAC/E module.

"Scan or Channel Data
Overflow" error messages
during data acquisition.
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This section provides a list of events and the associated parameters that can be added to a time
program in an instrument method. Refer to Table A-1.

For details of the parameters, refer to Table A-2.

Note: The Comment parameter is omitted from the following table but it is available for every
event.

Table A-1 Time Program Events

ParametersDescriptionEvent

At Time (min)Zero the detector output.Auto Zero

• Temperature (ºC)

• At Time (min)

Set the capillary temperature.Capillary
Temperature

At Time (min)Indicate the end of the method. Only one End
event is allowed in a method and it must be
the last event in the time program.

End

• Pressure (psi or mbar)

• Duration (s)

• Pressure Direction

• Tray Positions

• Increment Every Runs

Inject the sample using pressure.Inject Pressure

• Pressure (psi or mbar)

• Duration (s)

• Pressure Direction

• Tray Positions

• Increment Every Runs

Inject the sample using pressure.
This event allows for a higher pressure and a
longer duration than the Inject Pressure event.
Use this event to completely fill the capillary
with sample.

Inject Pressure
Capillary Fill
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Vacuum (psi or mbar)

• Duration (s)

• Pressure Direction

• Tray Positions

• Increment Every Runs

Inject the sample using vacuum.Inject Vacuum

• Voltage (kV)

• Polarity

• Duration (s)

• Tray Positions

• Increment Every Runs

Inject the sample using voltage.Inject Voltage

At Time (min)Turn off the lamp at the specified time.Lamp Off

At Time (min)Turn on the lamp at the specified time.Lamp On

At Time (min)(LIF detector) Turn off the lasers at the
specified time.

Lasers Off

At Time (min)(LIF detector) Turn on the lasers at the
specified time.

Lasers On

• Relay 1

• Relay 2

• At Time (min)

Turn on the specified relays at the specified
time.

Relay On

• Pressure (psi or mbar)

• Duration (min)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Add a rinse event that uses pressure.Rinse Pressure
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Vacuum (psi or mbar)

• Duration (min)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Add a rinse event that uses vacuum.Rinse Vacuum

• Temperature (ºC)

• At Time (min)

Set the temperature of the sample cooler.Sample Storage
Temperature

• Current (µA)

• Duration (min)

• Ramp Time (min)

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using current.Separate Current

• Current (µA)

• Duration (min)

• Ramp Time (min)

• Pressure (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using current and
pressure.

Separate Current
Pressure
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Current (µA)

• Duration (min)

• Ramp Time (min)

• Vacuum (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using current and
vacuum.

Separate Current
Vacuum

• Power (W)

• Duration (min)

• Ramp Time (min)

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using power.Separate Power

• Power (W)

• Duration (min)

• Ramp Time (min)

• Pressure (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using power and
pressure.

Separate Power
Pressure
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Power (W)

• Duration (min)

• Ramp Time (min)

• Vacuum (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using power and vacuum.Separate Power
Vacuum

• Pressure (psi or mbar)

• Duration (min)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using pressure.Separate Pressure

• Vacuum (psi or mbar)

• Duration (min)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using vacuum.Separate Vacuum

• Voltage (kV)

• Polarity

• Duration (min)

• Ramp Time (min)

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using voltage.Separate Voltage
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Voltage (kV)

• Polarity

• Duration (min)

• Ramp Time (min)

• Pressure (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using voltage and
pressure.

Separate Voltage
Pressure

• Voltage (kV)

• Polarity

• Duration (min)

• Ramp Time (min)

• Vacuum (psi or mbar)

• Pressure Direction

• Tray Positions

• Increment Every Runs

• At Time (min)

Separate the sample using voltage and
vacuum.

Separate Voltage
Vacuum

At Time (min)Stop data collection.Stop Data

• Duration (min)

• Tray Positions

• Increment Every Runs

• At Time (min)

Add a wait event.Wait
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Table A-1 Time Program Events (continued)

ParametersDescriptionEvent

• Channel

• Wavelength (nm)

• Bandwidth (nm)

• At Time (min)

(PDA detector) Change the wavelength for the
specified channel in the PDA detector.

Note: The wavelength range (wavelength ±
½ bandwidth) must be between 186 nm and
604 nm.

Wavelength PDA
Detector

• Wavelength (nm)

• At Time (min)

(UV detector) Change the wavelength for
Channel 1 in the UV detector.

Wavelength UV
Detector
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Parameters for Time Program Events
The parameters are listed in alphabetical order.

Table A-2 Parameters for Time Program Events

DetailsParameter

The time to start this event, expressed as the time from the first event
with the At Time parameter equal to 0.

At Time (min)

(PDA detector) The bandwidth for a Wavelength PDA Detector event,
from 6 nm to 252 nm.

Note: The wavelength range (wavelength ± ½ bandwidth) must be
between 186 nm and 604 nm.

Bandwith (nm)

(PDA detector) The channel in the PDA detector to be set to the
specified wavelength.

Channel

The current to be applied during the event, from either –300.0 µA to
3.0 µA or 3.0 µA to 300.0 µA.

• Values from 3.0 µA to 300.0 µA are normal polarity (+ at the inlet
and – at the outlet).

• Values from –300.0 µA to –3.0 µA are reverse polarity (– at the
inlet and + at the outlet).

Current (µA)

The duration of the event.

Note: For pressure and vacuum events, the duration must be long
enough to allow the system to come to the specified pressure (or
vacuum). Refer to About the Duration for Pressure and Vacuum
Events.

Duration (s or min)

The number of runs after which the inlet and outlet vials should
increment. Type 0 if the vial should not increment. Refer to About Vial
Incrementing.

Increment Every Runs

The direction of the current to be applied during the event. Options
are:

• Normal (+): + at the inlet and – at the outlet.

• Reverse (-): – at the inlet and + at the outlet.

Polarity
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Table A-2 Parameters for Time Program Events (continued)

DetailsParameter

The power to be applied during the event, from –9.000 W to 9.000 W.

• Values from 0.001 W to 9.000 W are normal polarity (– at the inlet
and + at the outlet).

• Values from –9.000 W to –0.001 W are reverse polarity (– at the
inlet and + at the outlet).

Power (W)

The pressure to be applied during the event.

Note: The system requires time to come to pressure. If the Duration
parameter is too short, the specified pressure can't be reached. Refer
to About the Duration for Pressure and Vacuum Events.

Pressure (psi or mbar)

The direction of the pressure to be applied during the event. Options
are:

• Forward: From inlet to outlet.

• Reverse: From outlet to inlet.

• Simultaneous: In both directions at once.

Pressure Direction

The time required for the system to reach the specified pressure,
voltage, power, or current.

Ramp Time (min)

The relay to be opened or closed.Relay 1

The relay to be opened or closed.Relay 2

The temperature for the cartridge or sample cooler.Temperature (ºC)

The inlet and outlet vials for the event. For each vial, specify a tray
and a position. Refer to About Tray Positions.

Tray Positions

The vacuum to be applied during the event, from 0.1 psi to 5.0 psi (or
6.9 mbar to 344.7 mbar).

Note: The system requires time to come to vacuum. If the Duration
parameter is too short, the specified vacuum can't be reached. Refer
to About the Duration for Pressure and Vacuum Events.

Vacuum (psi or mbar)
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Table A-2 Parameters for Time Program Events (continued)

DetailsParameter

The voltage to be applied during the event, from –30.0 kV to 30 kV
for any of the Separation Voltage events and –10.0 kV to 10 kV for
the Inject Voltage event.

The direction of the voltage is set by the Polarity parameter.

Voltage (kV)

The wavelength for the event, from 190 nm to 600 nm.Wavelength (nm)

About the Duration for Pressure and Vacuum Events
The system requires time to come to pressure (or vacuum). If the duration is too short, then the
specified pressure or vacuum cannot be reached. Use the following tables to make sure that the
duration is long enough. Refer to Table A-3 and Table A-4.

Table A-3 Required Duration to Reach Pressure

Set the duration to at least...To reach this pressure...

1.0 sec6.9 mbar0.1 psi

1.5 sec13.8 mbar0.2 psi

2.0 sec20.7 mbar0.3 psi

2.5 sec27.6 mbar0.4 psi

3.0 sec34.5 mbar0.5 psi

3.4 sec48.3 mbar0.7 psi

3.5 sec137.9 mbar2.0 psi

3.8 sec344.7 mbar5.0 psi

5.0 sec655.0 mbar9.5 psi

6.3 sec1723.7 mbar25.0 psi

Table A-4 Required Duration to Reach Vacuum

Set the duration to at least...To reach this vacuum...

2.0 sec6.9 mbar0.10 psi

2.5 sec10.3 mbar0.15 psi
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Table A-4 Required Duration to Reach Vacuum (continued)

Set the duration to at least...To reach this vacuum...

3.0 sec20.7 mbar0.30 psi

3.5 sec27.6 mbar0.40 psi

4.0 sec34.5 mbar0.50 psi

About Tray Positions
The Tray Positions parameter is used to specify the positions of the capillary inlet and outlet for
Rinse, Inject, Separate, or Wait events.

Parameters for Tray Positions are:

• Inlet Vial: The inlet vial for the next event, from A1 to F6.

• Inlet Tray: The inlet tray for the next event, either Buffer or Sample. For Inject events, Sample
List is also available. Refer to Sample Vial Positions for Inject Events.

• Outlet Vial: The outlet vial for the next event, from A1 to F6.

• Outlet Tray: The outlet tray for the next event, either Buffer or Sample. For Inject events,
Sample List is also available. Refer to Sample Vial Positions for Inject Events.

In the PA 800 Plus System, the geometry of the sample and buffer trays and the dimensions of
the capillary cartridge limit access to all 36 positions in the tray. For example, if the capillary inlet
is in A6 in the buffer inlet tray, then the capillary outlet cannot access F6 in the buffer outlet tray.
These incompatible positions are sometimes referred to as "tray collisions" or "vial collisions".

The software checks the positions and warns the user of any collisions.

Combinations that do not cause a collision are shown in the following table. Refer to Table A-5.

Table A-5 Inlet and Outlet Columns that Do Not Cause a Collision

Compatible Outlet ColumnsInlet Columns

A to CA to F

A to DB to F

A to EC to F

A to FD to F
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Sample Vial Positions for Inject Events

The Inject event is used to inject the sample to the capillary before the separation begins. The
positions of the vials containing the sample for Inject events can be specified in the instrument
method or in the sample set method.

1. To set the vial positions in the instrument method, edit the Tray Positions parameter for any
Inject event.

2. To set the vial positions in the sample set method, do the following:

a. In the instrument method, select Sample List for the Inlet Tray in the Tray Positions
parameter.

b. In the sample set method, edit the vial positions in the Plate/Well field.

About Vial Incrementing
Vial incrementing is an automated process to advance the inlet or outlet vials after a specified
number of cycles of a method. Vial incrementing eliminates the need to create new methods if
different vial positions are needed during the course of a sample set method. Without vial
incrementing, vials can overflow with liquid that backs up in the interface block, pressure manifold,
and other parts of the system. Additionally, without vial incrementing the ionic strength of the buffer
can be depleted.

Vial incrementing is enabled for the Rinse, Inject, Separate, and Wait events in an instrument
method.

To use vial incrementing, type a value for number of runs in the Inlet and Outlet fields of the
Increment Every Runs parameter. Runs are the number of times a method set repeats before
vial incrementing occurs.

Vial incrementing restarts when the sample set method advances to a new method set.
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This section include the plate definitions for the buffer tray, the sample tray, and the SCIEX 96-well
sample plate. These plates must be defined in the EmpowerTM Software.

The files should be installed as part of the PA 800 Plus EmpowerTM Driver installation.

If they are missing and the plates need to be defined, copy the text, paste it in a text editor, and
then save the file.
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PA800Plus Sample Tray Plate Definition File
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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PA800Plus 96 Well Sample Tray Plate Definition
File
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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PA800Plus Buffer Tray Plate Definition File
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On

PA 800 Plus EmpowerTM DriverUser Guide
59 / 62RUO-IDV-03-9721-A

Plate Definition Files



During installation, the FSE should have familiarized or reviewed the following with the customer:

• Software functions:

• USB license

• Creating, editing, and saving instrument methods

• Configuring the software to use multiple plates

• Direct control of the system, including:

• Instrument status

• Status field

• Parameter tabs and buttons

• Running a single sample or a sample set method

• Stopping a run

• Viewing error messages in the EmpowerTM Software Message Center window

• Installing a cartridge

• Loading samples

• For systems with more than one detector, changing detectors

• Maintenance procedures
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Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX UniversityTM

Purchase Consumables
Reorder SCIEX consumables online at store.sciex.com. To set up an order, use the account
number, found on the quote, order confirmation, or shipping documents. The SCIEX online store
is currently limited to the US, UK, and Germany but will be expanding to other countries in the
future. For customers in other countries, contact the local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical issues
that might arise. For more information, visit the SCIEX website at sciex.com or contact us in one
of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.
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Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the Customer Reference DVD that comes with
the system or component.

The latest versions of the documentation are available on the SCIEX website, at
sciex.com/customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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